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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject 
to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. 
No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published April 2026. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in severe 
civil or criminal penalties. 

All trademarks are the property of their respective owners. 



Installation Guide iii 

Contents 
Overview ................................................................................................................................................................................................. 1 

Additional Information .................................................................................................................................................................. 1 

License Renewal.......................................................................................................................................................................... 1 

Documentation ............................................................................................................................................................................ 1 

Compatibility Matrix .................................................................................................................................................................. 1 

Feedback ........................................................................................................................................................................................ 2 

If You Need Assistance ............................................................................................................................................................ 2 

Before You Begin ................................................................................................................................................................................. 3 

WorkBook Update Program ........................................................................................................................................................ 3 

Logical Tiers Overview .................................................................................................................................................................. 3 

Installation Order: High-Level Overview ............................................................................................................................... 3 

Which Type of Installation Am I Performing?..................................................................................................................... 4 

Technical Considerations ........................................................................................................................................................... 4 

Unsupported Environments .................................................................................................................................................. 4 

Recommended Daily Activities ............................................................................................................................................ 4 

Platform Virtualization ................................................................................................................................................................. 4 

Prerequisites .......................................................................................................................................................................................... 5 

System Requirements ................................................................................................................................................................... 5 

Software Requirements ........................................................................................................................................................... 5 

Hardware Requirements .......................................................................................................................................................... 6 

Ensure Permissions Required for Installing WorkBook .................................................................................................... 6 

Ensure Credentials for Microsoft SQL Server Database ................................................................................................ 7 

Verify the Name of Your SQL Server Instance ................................................................................................................... 7 

Preinstallation ....................................................................................................................................................................................... 8 

Preinstallation Checklists ............................................................................................................................................................ 8 

Single-Server ............................................................................................................................................................................... 8 

Dual-Server (Two-Tier)............................................................................................................................................................. 9 

Restore the WorkBook Database .......................................................................................................................................... 10 

Installation Procedures .....................................................................................................................................................................11 

Single-Server Installation ............................................................................................................................................................11 

Step 1: Install the Web/Application (IIS) and Database Server Tiers ...................................................................11 

Step 2: Create the Website and Configure the IIS Settings .................................................................................. 13 



Installation Guide iv 

Step 3: Download the Agent for Your WorkBook Version ......................................................................................14 

Step 4: Configure the Agent Server Tier ........................................................................................................................14 

Step 5: Create a Scheduled Task ....................................................................................................................................... 16 

Two-Server Installation............................................................................................................................................................... 17 

Step 1: Install the Web/Application (IIS) Server Tier ................................................................................................. 17 

Step 2: Create the Website and Configure the IIS Settings .................................................................................. 19 

Step 3: Download the Agent for Your WorkBook Version ..................................................................................... 20 

Step 4: Configure the Agent Server Tier ........................................................................................................................ 21 

Step 5: Create a Scheduled Task ...................................................................................................................................... 22 

Upgrade Procedures ........................................................................................................................................................................ 24 

Upgrade from WorkBook 9.1 or Newer ............................................................................................................................... 24 

Upgrade from WorkBook 8 or Earlier Versions ................................................................................................................ 24 

Migrate/Upgrade to a New Server ....................................................................................................................................... 24 

Step 1: Install the Web/Application (IIS) Server Tier ................................................................................................ 25 

Step 2: Download the Agent for Your WorkBook Version ..................................................................................... 26 

Step 3: Configure the Agent Server Tier ....................................................................................................................... 27 

Step 4: Remove Obsolete Websites ............................................................................................................................... 28 

Post Installation/Upgrade.............................................................................................................................................................. 29 

Post-Installation Configuration .............................................................................................................................................. 29 

Step 1: Update the BasicURL .............................................................................................................................................. 29 

Step 2: Get Your Subscription Key .................................................................................................................................. 29 

Migration Reconfiguration ............................................................................................................................................................. 31 

Storage Providers.......................................................................................................................................................................... 31 

Emails ................................................................................................................................................................................................ 32 

A-record ........................................................................................................................................................................................... 32 

Appendix A: Microsoft Internet Information Server (IIS) Installation on Windows Server ............................... 33 

Microsoft (IIS) is already Installed on Windows Server 2019 to 2022 ................................................................... 33 

Installing Microsoft IIS for the First Time on Windows Server 2019 to 2022 ..................................................... 33 

Installing Microsoft .NET 8 ....................................................................................................................................................... 34 

Appendix B: Creating the Website and Configuring the IIS Settings (Alternate Method) ............................... 35 

Create the Website and Configure the IIS Settings ..................................................................................................... 35 

Remove Report as Application ............................................................................................................................................... 35 

Rename the Report Folder ....................................................................................................................................................... 35 

Create a Separate Report Website....................................................................................................................................... 35 



Installation Guide v 

Configure the web.config File ................................................................................................................................................ 36 

Edit the Rules Using URL Rewrite ......................................................................................................................................... 37 



Installation Guide 1 

Overview 
This guide contains technical installation and setup information for the staff at your company who 
maintain the hardware and software that are required to install Deltek WorkBook. 

Additional Information 

License Renewal 
For single-server installations, you can renew your license online. For dual-server installations, the Web 
Server must have access to the Internet for you to renew your license. 

If you do not have Internet access, you can renew your license manually within 14 days after installation. 

Documentation 
You can access all WorkBook documentation via the WorkBook Resource Center. The top menu bar 
provides links to videos, training, and more. Scroll down to find Release Notes, Online Help, Coffee 
Breaks, the Ideas Portal, and popular learning assets. Bookmark this link so that you always have easy 
access to the latest information: 

https://enablement.deltek.com/resource-center/workbook 

You can perform a Deltek Support Center search for additional documents at the following link: 

https://deltek.custhelp.com/app/answers/detail/a_id/79935 

For information about the WorkBook API, you can access the Deltek WorkBook API Guide at the 
following link: 

https://workbookapi.deltek.com/?version=latest 

Compatibility Matrix 
Information about platform requirements is maintained in the Deltek Product Support Compatibility 
Matrix, located on the Deltek Support Center. In the Matrix, search on WorkBook to navigate quickly to 
the information that you need. 

Deltek Product Support Compatibility Matrix 

Notes: 

▪ This WorkBook release contains major technology and configuration changes that
affect the typical upgrade scenario. Before performing the upgrade, review Before
You Begin Deployment to understand how these changes will affect your
deployment. 

▪ This document assumes that the person who is installing WorkBook is capable of
installing, configuring, or troubleshooting MS SQL databases, IIS, Windows
Authentication, and Task Scheduler, among others.

https://enablement.deltek.com/resource-center/workbook
https://deltek.custhelp.com/app/answers/detail/a_id/79935
https://workbookapi.deltek.com/?version=latest
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Feedback 
If you have comments or questions about this document, you can submit them to 
DeltekDocumentationFeedback@deltek.com. 

If You Need Assistance 
If you need assistance installing or updating WorkBook, submit a request to Deltek Support Services by 
navigating to https://deltek.custhelp.com » Submit a Case and completing the online form. 

mailto:DeltekDocumentationFeedback@deltek.com
https://deltek.custhelp.com/
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Before You Begin 
Before you begin deployment, review the topics in this section. 

WorkBook Update Program 
WorkBook uses its own update manager, WorkBook Update 6, to update and install WorkBook files. This 
tool connects to the Internet and downloads the files that are required to complete a WorkBook update 
or installation. 

Logical Tiers Overview 
WorkBook uses a multitier architecture. Various components of the WorkBook application are 
distributed to logical tiers for performance and scalability. The logical tiers are as follows: 

▪ Web/Application (IIS) Server Tier – This tier performs WorkBook’s functional process logic.
After a client browser sends a request, this tier processes that request, such as retrieving stored
data, and then returns the result to the client browser. This tier uses IIS to host the WorkBook
applications.

▪ Agent Server Tier – This tier enables users to schedule agents that run in the background. The
following are examples of agents that can run on the Agent Server:

▪ Scheduled reports

▪ Mail imports

▪ Calendar synchronization

▪ Database maintenance

▪ Database Tier – This tier consists of the SQL Server Database Server(s) where the WorkBook
data is stored and and from which it is retrieved.

Installation Order: High-Level Overview 
To install WorkBook correctly, you must complete installation of the server roles in the following order: 

1. Install a blank and/or sample WorkBook database on the Database Server tier. You have the
option to update an existing database.

2. Install WorkBook on the Web/Application Server tier.

3. Install the Agent Server on the server that runs the Web/Application Server tier.

Note: If you are having issues installing the WorkBook Update 6 application, try to download 
it using your browser. 
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Which Type of Installation Am I Performing? 
Your WorkBook installation falls into one of the following categories: 

▪ Install WorkBook for the first time with a new database. For information, see Installation 
Procedures. 

▪ Upgrade a server that already has WorkBook installed. For information, see Upgrade Procedures. 

Technical Considerations 

Unsupported Environments 
WorkBook does not support the following environments: 

▪ You cannot perform a single-server deployment on the Microsoft Small Business Server. Only 
the WorkBook database tier can be installed on this server. 

▪ You cannot install any WorkBook tier on: 

▪ The Microsoft ISA/TMG server or any other software-based firewall (except Windows 
firewall). 

▪ A domain controller. 

Recommended Daily Activities 
Deltek recommends that you complete the following activities on your database daily: 

1. Check database integrity. 

2. Perform a complete backup. 

Platform Virtualization 
Virtual environment software, such as VMware®, resides in the hardware layer underneath the operating 
system and is used to partition a single server into a multiple-server/multiple-operating-system 
environment. Deltek’s Product Development makes limited use of virtual environments. 

 

Note: See KB Article 78800, Customer Use of Cloud-Based and Virtualized Environments, 
on the Deltek Support Center site (https://support.deltek.com) for more information. 

https://support.deltek.com/
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Prerequisites 

System Requirements 
Make sure that your software and hardware systems meet the minimum WorkBook requirements. 

If your current server does not meet the minimum software requirements as shown in the following 
tables, you must migrate WorkBook to a new server. 

Software Requirements 

Software  1 to 100 Users 101 to 500+ Users 

SQL Server MS SQL Server Standard or Enterprise 2019 

Notes: 

▪ If you have fewer than 20 WorkBook users in your organization, you 
can use MS SQL Server Express 2019. 

▪ Default server-level collation must be set to 
SQL_Latin1_Genereal_CP1_CI_AS 

Windows Server MS Windows Server 2019+ (2019 to 2022) 

Number of Servers 1 Server 1 Web Server 

1 Database Server 

Internet Information 

Services (IIS) 

                                8.5 or higher 

NOTE: Make sure that the IIS features that WorkBook requires are installed 

or enabled. For more information, see Installing Microsoft IIS for the First 
Time on Windows Server 2019 to 2022. 

ASP.NET Enabled 

.NET 4.8 and 8.0 

NOTE: The server requires that you have Microsoft .NET 8 installed. For 

instructions, see Installing Microsoft .NET 8. 

Browser ▪ Latest Chrome version for Windows and macOS 

▪ Latest Safari version for macOS 

▪ Latest Firefox version for Windows and macOS 

▪ Latest Microsoft Edge version for Windows 10 
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Hardware Requirements 

Software / 
Hardware 

1 to 100 Users 101 to 500+ Users 

Processor (Web and 

SQL Servers) 

2.5GHz Quad Core 2.5GHz Quad Core 

RAM 8 Gb SQL Server: 32 Gb 

Web Server: 8 Gb 

Hard Disk Drive High-performance SATA or SAS 

Disks in RAID 1 

Web Server: 2 x SATA Disks in RAID 1 

Hard Disk Space 

(Estimated) 

Web Server: 3 Gb + 10 Gb temporary space on the operating system disk. 

NOTE: This estimate does not include file storage and the space used by the 

operating system and other applications. 

Ensure Permissions Required for Installing WorkBook 
The person who installs WorkBook on the server tiers must have the following rights and privileges. 

Tier Permissions Required 

Web Server Tier and 
Agent Server Tier 

▪ The Windows account of the person who performs the installation must
be a member of the Local Administrator group on the server.

▪ The person who performs the installation must have/know the credentials
of the user account that was in the database as specified in the
WorkBook Credentials for Microsoft SQL Server Database section. This
account has the user rights that the installation requires when it displays
the database platform connection information.

Database Server Tier ▪ The person who performs the installation must know the credentials of
the user account that was created in the database as specified in the

WorkBook Credentials for Microsoft SQL Server Database section. This
account has the user rights that the installation requires when it displays
the database platform connection information.
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Ensure Credentials for Microsoft SQL Server Database 
During the installation of WorkBook, you must provide a set of SQL Server Authentication credentials or 
a domain account that, at minimum, should have the roles of db_owner of the WorkBook database and 
dbcreator on the SQL Server. 

 

WorkBook supports both SQL Server authentication modes: Windows Authentication Only mode or 
SQL Server and Windows Authentication mode, also known as Mixed Mode. 

 

Verify the Name of Your SQL Server Instance 
The default installation uses the Server Name for the connection and is installed as an instance named 
SSQLSERVER. Sometimes, Microsoft SQL Server is installed using an instance name other than the 
default name (MSSQLSERVER). The SQL Server Express Edition is installed as the named instance 
SQLEXPRESS. 

▪ When connecting to the default SQL Server Database Engine instance, use the name of your 
database server. The SQL Server automatically maps the default instance of the Database 
Engine to the Server Name when it accepts connections. 

▪ When connecting to a named instance of SQL Server Database Engine, specify the name of the 
SQL Server plus the instance in the connection in the format of 
SERVERNAME\INSTANCENAME. 

For example, if your SQL Server is named SQLSERVER1, and you installed it to an instance 
named SQLExpress, you must specify the server connection information in the format of 
SQLSERVER1\SQLExpress. 

▪ If you do not know the name of your SQL Server instance, or you are unable to connect to your 
database server after installation, see Determine Whether the Database Engine Is Installed and 
Started at http://msdn.microsoft.com/en-us/library/ms366339.aspx. 

If you still experience errors when you try to connect to your database server, verify that the 
Windows firewall or any other firewall is not blocking access to the SQL Server Database Engine. 

 

Note: If you choose to use a Domain Account, Deltek recommends that you rotate the 
password at least once yearly. Create this account before you install WorkBook because it is 
used by the Web and Agent Tiers to connect to the database. 

Note: For more information about SQL Server authentication modes, see Change Server 
Authentication Mode at https://msdn.microsoft.com/en-
us/library/ms188670(v=sql.120).aspx. 

Note: See Configure a Windows Firewall for Database Engine Access at 
http://msdn.microsoft.com/en-us/library/ms175043.aspx. 

http://msdn.microsoft.com/en-us/library/ms366339.aspx
https://msdn.microsoft.com/en-us/library/ms188670(v=sql.120).aspx
https://msdn.microsoft.com/en-us/library/ms188670(v=sql.120).aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Preinstallation 

Preinstallation Checklists 
This section includes a separate checklist for each of the following installation models: 

▪ Single Server 

▪ Dual-Server (Two-Tier) 

Single-Server  
 
 
 

Step Related Topics 

1.  Verify that your system meets WorkBook 9 
software and hardware requirements. This 
includes the Windows server, SQL Server, .NET, 
and IIS versions, as well as the hard disk storage 
size. 

Note: The server requires that you have 
Microsoft .NET 8 installed. For instructions, see 
Installing Microsoft .NET 8. 

▪ System Requirements 

▪ Microsoft .NET 8 Download Site 

▪ Appendix A: Microsoft Internet 
Information Server (IIS) Installation 
on Windows Server  

2.  If you are not going to use the default 
installation folder, make sure that your 
preferred folder exists before you install 
WorkBook.  

 

3.  Verify that the user account performing the 
installation is a member of the local Windows 
System Administrators group. 

▪ Permissions Required for Installing 
WorkBook 

4.  Make sure that you have valid SQL Server 
credentials or a domain account available for 
use during the installation. 

▪ WorkBook Credentials for 
Microsoft SQL Server Database 

5.  Use the SQL Server Configuration Manager to 
enable the TCP/IP and Shared Memory 
protocols on the SQL Server. 

▪ Enable or Disable a Server 
Network Protocol (SQL Server 
Configuration Manager)  

https://dotnet.microsoft.com/en-us/download/dotnet/8.0
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
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Dual-Server (Two-Tier) 

Database Tier 

You must perform this step before you install WorkBook on your Web Server. 

Step ▪ Related Topics

1. Verify that the Database Server meets 
WorkBook’s software and hardware 
requirements. 

▪ System Requirements

2. Verify that the user account that performs the 
installation is a member of the local Windows 
System Administrators group. 

▪ Permissions Required for Installing
WorkBook

3. Make sure that you have valid SQL Server 
credentials or a domain account available for 
use during the installation. 

▪ WorkBook Credentials for
Microsoft SQL Server Database

4. Use the SQL Server Configuration Manager to 
ensure that the TCP/IP and Shared Memory 
protocols are enabled on your report server 
and database server. 

▪ Enable or Disable a Server
Network Protocol (SQL Server
Configuration Manager)

Web Application and Process Server Tier 

Step Related Topics 

1. Verify that the Web Application and Process 
Server meets WorkBook’s software and 
hardware requirements. 

Note: The server requires that you have 
Microsoft .NET 8 installed. For instructions, see 
Installing Microsoft .NET 8. 

▪ System Requirements

▪ Microsoft .NET 8 Download Site

▪ Appendix A: Microsoft Internet
Information Server (IIS)
Installation on Windows Server

2. If you are not going to use the default 
installation folder, make sure that your 
preferred folder exists before you install 
WorkBook. 

3. Verify that the user account that performs the 
installation has the proper account credentials 
as stated in the database tier checklist. 

▪ WorkBook Credentials for
Microsoft SQL Server Database

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
https://dotnet.microsoft.com/en-us/download/dotnet/8.0
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Step Related Topics 

4.  Ensure that you have the following information 
before you start the installation: 

▪ Database Server\SQL instance name 

▪ Database Server credentials 

▪ WorkBook Credentials for 
Microsoft SQL Server Database 

▪ Verify the Name of Your SQL 
Server Instance. 

Restore the WorkBook Database 
Before you install WorkBook, you must restore the WorkBook database on your SQL Server. If you do not 
have the WorkBook database, contact DeltekSupport@deltek.com. 

For information on how to restore an SQL database, see Restore a Database using SQL Server 
Management Studio. 

 

Note: If you experience connection errors to your database and have verified the previous 
steps, check that access is not being blocked by Windows or your firewall. For more 
information, see Configure a Windows Firewall for Database Engine Access. 

mailto:DeltekSupport@deltek.com
https://docs.microsoft.com/en-us/sql/relational-databases/backup-restore/restore-a-database-backup-using-ssms?view=sql-server-2016
https://docs.microsoft.com/en-us/sql/relational-databases/backup-restore/restore-a-database-backup-using-ssms?view=sql-server-2016
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Installation Procedures 

 

Single-Server Installation 
This section provides instructions for installing all WorkBook tiers on a single server for organizations 
that prefer the one-server deployment model. This deployment model is suitable for demonstration 
purposes or for small organizations that have simple deployment needs. 

When you choose the one-server deployment model, you install all WorkBook tiers (Web, Agent, and 
Database) on the same server. 

 

Step 1: Install the Web/Application (IIS) and Database Server Tiers 
1. Create the WorkBook installation folder on your server. 

2. Navigate to https://update.workbook.net/wbupdate6/ and click Install on the page to download 
WorkBook Update 6. This option also downloads the Microsoft .NET and Windows Installer 
prerequisites. 

If you already have the prerequisites installed, you can launch WorkBook Update 6 directly from 
the page. 

 

3. Right-click setup.exe and then click Run as administrator on the context menu. Alternatively, 
you can double-click setup.exe and then click File » Elevate Application in the WorkBook 
Update 6 dialog box. 

Note: If you encounter any errors during the installation, send the installation log file to 
WorkBookSupport@deltek.com. 

Notes:  

▪ Before you begin your installation, see Preinstallation Checklists and System 
Requirements. 

▪ To review the various deployment options, see Before You Begin Deployment. 

Note: Make sure to restore the WorkBook database before launching WorkBook Update 6. 
For more information, see Restore the WorkBook Database. 

https://update.workbook.net/wbupdate6/
mailto:WorkBookSupport@deltek.com
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4. Use the WorkBook Update 6 dialog box to specify the database information and installation path
for WorkBook V9 Website. If you are using Trusted Authentication, leave the username and
password fields empty.

Note: When you select a Database Server in WorkBook Update 6, it automatically populates 
the V9 Website Path field, as shown in the following example. If you want to change the 
default paths, make sure that the destination folders that you want to use already exist 
before you start with the installation. The maximum path name length from the root to the 
installation folder should not exceed 100 characters. 
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5. In the Update group box, select the following options:

▪ Patch

▪ Static Data

▪ V9

▪ Backend

6. In the New version section, use the drop-down list to select the version of WorkBook that you
want to install.

7. In the V9 Website Path field, specify the location where you want to install the V9 Website
Application files.

8. Click Start and wait for the installation to finish.

Step 2: Create the Website and Configure the IIS Settings 

1. Open the Internet Information Services (IIS) Manager.

2. Expand the server element.

3. Right-click Application Pools and click Add Application Pool… on the context menu.

4. Set the name for the Application Pool that is for the WorkBook website, set .NET CLR version to
No Managed Code, Managed pipeline mode to Integrated and Start application pool
immediately checked.

5. Right-click Application Pools and click Add Application Pool… on the context menu.

6. Set the name for the Application Pool that is for Reports, set .NET CLR version to .NET CLR
Version v4.0, Managed pipeline mode to Integrated and Start application pool immediately
checked.

Notes: 

▪ Select the Backend option only if you are upgrading from one major version to
another. For example, select this option if you are upgrading from version 911000 to
version 912000. If you are upgrading from version 911000.102 to version
911000.107, do not select this option because both versions belong to the same
major release (911000).

▪ For version 913600 and higher the HTTPS is always enabled. You can ignore the
check box Use HTTPS. Remember to install SSL Certificate for HTTPS.

Note: Select a stable version of WorkBook, unless told otherwise by Deltek. 

Note: If you want to create a separate website for reports, use the following method 
instead: Appendix B: Creating the Website and Configuring the IIS Settings (Alternate 
Method). Having the reports on a separate website can help to speed up processing time 
and can generally be less demanding of system resources. 
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7. Right-click Sites and click Add Website on the context menu. 

8. Use the fields and options in the Add Website dialog box to create the WorkBook website, 
Select… Application pool and choose the one that you created in step 4. then click OK. 

Make sure that the Physical Path field points to the WorkBook installation folder that you 
specified when you installed the Database and Web tiers, and that the Port field points to an 
unused port number, then click OK. 

9. Expand the newly created WorkBook website. 

10. Right-click the api folder and click Convert to Application on the context menu. 

11. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 4. and accept the other default settings and click OK. 

12. Right-click the Report folder and click Convert to Application on the context menu. 

13. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 6. and accept the other default settings and click OK. 

14. Expand Report. 

15. Right click the api folder and click Convert to Application on the context menu. 

16. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 6. and accept the other default settings and click OK. 

Step 3: Download the Agent for Your WorkBook Version 
When installing WorkBook in a single-server or dual-server setup, you must download the agent version 
that matches your WorkBook installation. 

1. Click https://update.workbook.net/913006 to go to the download site. 

The agent version number after the slash corresponds to the version number of the base 
WorkBook application. 

2. Download the WorkBook agent version that corresponds to your installation’s build number. The 
last two digits of the file name correspond to the build number of your WorkBook installation. 
For example, if your WorkBook build number is 912000.27, download 
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the 
WorkBook Update 6 dialog box. 

3. Create an Agent folder for the WorkBook agent on the server where your Web/Application 
Server is installed. The Agent folder must be on the same level as the installation folder for your 
WorkBook installation. 

4. Extract the contents of the zip file to the Agent folder. 

Step 4: Configure the Agent Server Tier 
1. In the WorkBook installation folder on your Web/Application (IIS) Server, right-click the 

appsettings.Production.json file and use the context menu to open it in Notepad. 

2. In Notepad, copy the connection string from the appsettings.Production.json file. 

https://update.workbook.net/913006
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3. In the wbAgent folder of your Web/Application (IIS) Server, right-click the 
WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in 
Notepad. 

4. In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string 
with the one that you copied from the appsettings.Production.json file in the WorkBook 
installation folder. 
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5. Save the file. 

Step 5: Create a Scheduled Task  
1. Launch Task Scheduler and create a task (Action » Create Task). 

2. On the General tab of the Create Task dialog box, enter the task name. 

3. Select the following options: 

▪ Run whether User is Logged on or not. 

Do not select the Do not Store Password option. 

▪ Run with Highest Privileges 
4. On the Trigger tab of the Create Task dialog box, click New. 

5. In the New Trigger dialog box, select the following options, then click OK: 

▪ Begin the task on a schedule 

▪ Daily 

▪ Recur every 1 day 

▪ Repeat task every 1 hour for an indefinite duration 

▪ Enable the trigger 
6. On the Actions tab of the Create Task dialog box, click New. 

7. In the New Action dialog box, take the following actions, then click OK: 

▪ Select Start a Program in the Action field. 

▪ Use the Browse button to locate the WorkBook.Agent.ConsoleRunner.exe file in the Agent 
folder. 

8. In the Create Task dialog box, click OK. 
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Two-Server Installation 
This model is designed for medium- to large-sized companies that have adequate technical staff. In this 
setup, your SQL and IIS installations run on different servers. 

 

Step 1: Install the Web/Application (IIS) Server Tier 
1. Create the WorkBook installation folder on the server that hosts the IIS Server. 

2. Navigate to https://update.workbook.net/wbupdate6/ and click Install on the page to 
download WorkBook Update 6. This option also downloads Microsoft .NET and Windows 
Installer prerequisites. 

If you already have the prerequisites installed, you can launch WorkBook Update 6 directly from 
the page. 

 

3. Right-click setup.exe and then click Run as Administrator on the context menu. Alternatively, 
you can double-click setup.exe and then click File » Elevate Application in the WorkBook 
Update 6 dialog box. 

4. Use the WorkBook Update 6 dialog box to specify the database information and installation path 
for WorkBook V9 Website. If you are using Trusted Authentication, leave the username and 
password fields empty. 

 

Notes:  

▪ Before you begin your installation, see Preinstallation Checklists and System 
Requirements. 

▪ To review the various deployment options, see Before You Begin Deployment. 

Note: Make sure to restore the WorkBook database before launching WorkBook Update 6. 
For more information, see Restore the WorkBook Database. 

Note: When you select a Database Server in WorkBook Update 6, it automatically populates 
the V9 Website Path field, as shown in the following example. If you want to change the 
default paths, make sure that the destination folders that you want to use already exist 
before you start with the installation. The maximum length of the path name from the root to 
the installation folder should not exceed 100 characters. 

https://update.workbook.net/wbupdate6/
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5. In the Update group box, select the following options:

▪ Patch

▪ Static Data

▪ V9

▪ Backend
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6. In the New Version section, use the drop-down list to select the version of WorkBook that you 
want to install. 

 

7. In the V9 Website Path field, specify the location where you want to install the V9 Website 
Application files. 

8. Click Start and wait for the installation to finish. 

Step 2: Create the Website and Configure the IIS Settings 

 

1. On the server where you installed the Web/Application (IIS) Server tier, open the Internet 
Information Services (IIS) Manager. 

2. Expand the server element. 

3. Right-click Application Pools and click Add Application Pool… on the context menu. 

4. Set the name for the Application Pool that is for the WorkBook website, set .NET CLR version to 
No Managed Code, Managed pipeline mode to Integrated and Start application pool 
immediately checked. 

5. Right-click Application Pools and click Add Application Pool… on the context menu. 

6. Set the name for the Application Pool that is for Reports, set .NET CLR version to .NET CLR 
Version v4.0, Managed pipeline mode to Integrated and Start application pool immediately 
checked. 

7. Right-click Sites and click Add Website on the context menu. 

8. Use the fields and options in the Add Website dialog box to create the WorkBook website, 
Select… Application pool and choose the one that created in step 4. then click OK. 

Make sure that the Physical Path field points to the WorkBook installation folder that you 
specified when you installed the Database and Web tiers, and that the Port field points to an 
unused port number, then click OK. 

Note:  

▪ Select the Backend option only if you are upgrading from one major version to 
another. For example, select this option if you are upgrading from version 911000 to 
version 912000. If you are upgrading from version 911000.102 to version 
911000.107, do not select this option because both versions belong to the same 
major release (911000). 

▪ For version 913600 and higher the HTTPS is always enabled. You can ignore the 
check box Use HTTPS. Remember to install SSL Certificate for HTTPS. 

Note: Select a stable version of WorkBook, unless told otherwise by Deltek. 

Note: If you want to create a separate website for reports, use the following method 
instead: Appendix B: Creating the Website and Configuring the IIS Settings (Alternate 
Method). Having the reports on a separate website can help to speed up processing time 
and can generally be less demanding of system resources. 
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9. Expand the newly created WorkBook website. 

10. Right-click the api folder and click Convert to Application on the context menu. 

11. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 4. and accept the other default settings and click OK. 

12. Right-click the Report folder and click Convert to Application on the context menu. 

13. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 6. and accept the other default settings and click OK. 

14. Expand Report. 

15. Right click the api folder and click Convert to Application on the context menu. 

16. In the Add Application dialog box, make sure that the selected Application pool is the one from 
step 6. and accept the other default settings and click OK. 

Step 3: Download the Agent for Your WorkBook Version 
You must run the Agent from the server where your Web/Application (IIS) Server is installed. 

 

When you install WorkBook in a single-server or dual-server setup, you must download the Agent version 
that matches your WorkBook installation. 

1. Click http://update.workbook.net/912000 to go to the download site. 

The agent version number after the slash corresponds to the version number of the base 
WorkBook application. 

2. Download the WorkBook agent version that corresponds to your installation’s build number. The 
last two digits of the file name correspond to the build number of your WorkBook installation. 
For example, if your WorkBook build number is 912000.27, download 
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the 
WorkBook Update 6 dialog box. 

3. Create an Agent folder for the WorkBook agent on the server where your Web/Application 
Server is installed. The Agent folder must be on the same level as the installation folder for your 
WorkBook installation.  

4. Extract the contents of the zip file to the Agent folder. 

Notes:  

▪ This section applies only to clients who host WorkBook on their own servers. 

▪ You must extract the Agent to the Web/Application (IIS) Server and not to the SQL 
server. 

http://update.workbook.net/912000
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Step 4: Configure the Agent Server Tier  
1. In the WorkBook installation folder on your Web/Application (IIS) Server, open the api folder, 

right-click the appsettings.Production.json file and use the context menu to open it in 
Notepad. 

2. In Notepad, copy the connection string from the appsettings.Production.json file. 

 

3. In the wbAgent folder of your Web/Application (IIS) server, right-click the 
WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in 
Notepad. 

4. In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string 
with the one that you copied from the appsettings.Production.json file in the WorkBook 
installation folder. 
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5. Save the file. 

Step 5: Create a Scheduled Task  
1. On your Web/Application (IIS) Server, launch Task Scheduler and create a task (Action » Create 

Task).  

2. On the General tab of the Create Task dialog box, enter the task name. 

3. Select the following options: 

▪ Run whether User is Logged on or not. 

Do not select the Do not Store Password option. 

▪ Run with Highest Privileges 
4. On the Triggers tab of the Create Task dialog box, click New. 

5. In the New Trigger dialog box, select the following options, then click OK: 

▪ Begin the task on a schedule 

▪ Daily 

▪ Recur every 1 day 

▪ Repeat task every 1 hour for an indefinite duration 

▪ Enable the trigger 
6. On the Actions tab of the Create Task dialog box, click New. 
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7. In the New Action dialog box, take the following actions, then click OK: 

▪ Select Start a Program in the Action field. 

▪ Use the Browse button to locate the WorkBook.Agent.ConsoleRunner.exe file in the Agent 
folder. 

8. In the Create Task dialog box, click OK. 
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Upgrade Procedures 
Deltek encourages customers to upgrade to the latest version of WorkBook because: 

▪ New features are added only to the latest version.

▪ Deltek fixes software issues only in the latest version, except in critical situations.

▪ Deltek Support is typically available only for the latest and the next previous versions.

▪ The latest version incorporates the newest technologies and tools.

Before you install an upgrade, review the Deltek WorkBook Release Notes and perform a test conversion 
and test installation of the new version to ensure that your Company’s business processes are working 
properly in the new version. 

Upgrade from WorkBook 9.1 or Newer 
If you are upgrading from WorkBook 9.1 or a newer version, the upgrade is installed directly into the 
existing folder structure using the current WorkBook settings. 

Upgrade from WorkBook 8 or Earlier Versions 
If you are upgrading from WorkBook 8 or an earlier version, you might need to create one or more of the 
Application websites if they are missing. WorkBook uses any existing websites. 

Migrate/Upgrade to a New Server 
▪ If your existing WorkBook database server is on an SQL Server version that is no longer

supported, you must restore or move your database to a supported version before you install
the upgrade.

▪ If your existing WorkBook Web/Application Server is on a version of Windows that is no longer
supported, you must perform a new installation. WorkBook will not migrate any custom reports,
DLLs, web.config settings, or other configuration changes that are on the server. For more
information, see Installation Procedures.

Notes: 

▪ Before you begin your installation, review Preinstallation Checklists.

▪ To review the various deployment options, see Before You Begin Deployment.

▪ If you encounter any errors during the upgrade process, send the installation log file
to https://support.deltek.com.

▪ When it updates the Database Server tier, WorkBook creates a backup of the
database in the default backup directory.

https://support.deltek.com/
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Step 1: Install the Web/Application (IIS) Server Tier 
1. Navigate to https://update.workbook.net/wbupdate6/ and click Install on that page to 

download WorkBook Update 6. This option also downloads Microsoft .NET and Windows 
Installer prerequisites. 

2. Right-click setup.exe and then click Run as Administrator on the context menu. Alternatively, 
you can double-click setup.exe and then click File » Elevate Application in the WorkBook 
Update 6 dialog box. 

3. Use the WorkBook Update 6 dialog box to specify the database information and installation path 
for WorkBook’s V9 Website components. If you are using Trusted Authentication, leave the 
username and password fields empty. 

 

https://update.workbook.net/wbupdate6/
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4. In the Update group box, select the following options: 

▪ Patch 

▪ Static Data 

▪ V9 

▪ Backend 

5. In the New version section, use the drop-down list to select the version of WorkBook that you 
want to install. 

 

6. Click Start and wait for the installation to finish. 

Step 2: Download the Agent for Your WorkBook Version 

 

When you install WorkBook in a single-server or dual-server setup, you must download the Agent version 
that matches your WorkBook installation. 

1. Click https://update.workbook.net/913006 to go to the download site. 

The agent version number after the slash corresponds to the version number of the base 
WorkBook application. 

2. Download the WorkBook agent version that corresponds to your installation’s build number. The 
last two digits of the file name correspond to the build number of your WorkBook installation. 
For example, if your WorkBook build number is 912000.27, download 
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the 
WorkBook Update 6 dialog box. 

3. Go to Task Manager » Details and stop WorkBook.Agent.ConsoleRunner. 

 

Note: Select a stable version of WorkBook, unless told otherwise by Deltek. 

Notes:  

▪ This section applies only to clients who host WorkBook on their own servers. 

▪ If your SQL and IIS installations run on different servers, extract the Agent to the 
Web/Application (IIS) Server, and not to the SQL server. 

https://update.workbook.net/913006
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4. Delete the content of the Agent folder on the server where your Web/Application Server is
installed.

5. Extract the contents of the zip file to the Agent folder.

Step 3: Configure the Agent Server Tier 
1. In the WorkBook installation folder on your Web/Application (IIS) Server, right-click the

appsettings.Production.json file and use the context menu to open it in Notepad.

2. In Notepad, copy the connection string from the appsettings.Production.json file.

3. In the wbAgent folder of your Web/Application (IIS) server, right-click the
WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in
Notepad.

4. In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string
with the one that you copied from the appsettings.Production.json file in the WorkBook
installation folder.

5. Save the file.

6. Go to Task Manager » Details and check whether the WorkBook.Agent.ConsoleRunner.exe is
running. If not, open Task Scheduler and run the scheduled task.
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Step 4: Remove Obsolete Websites 
WorkBook has rendered the following websites obsolete: 

▪ “Mobile” API website. 

▪ WebAccess website. 

You can delete these websites and the files that are related to them. 
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Post Installation/Upgrade 
After you complete the installation or upgrade process, verify the installation to confirm that all 
prerequisite software is installed and that all installation steps were completed. 

To verify that your installation was successful: 

1. Open your browser and enter the URL to the WorkBook application, for example: 

http:\\<Web Server>\ 

2. Enter your User ID. If you are unsure of your user ID, enter admin. 

3. Enter your Password. If you are unsure of your password, leave this field empty. 

4. If you are able to log in, or if you receive a notification about an incorrect username or password, 
WorkBook has been installed successfully. 

 

Post-Installation Configuration 
After the installation is complete, you must perform the following configuration steps. 

Step 1: Update the BasicURL 
Run the following script to update the BasicURL to match the one that you supplied to WorkBook in IIS, 
where WORKBOOKURL is your WorkBook system’s URL. 

update SysVariabler set Vaerdi = 'WORKBOOKURL' where VariableNavn = 

'BasicURL' 

Step 2: Get Your Subscription Key 
1. Contact Deltek Support Services to get your Subscription Key and copy it. 

2. In WorkBook, navigate to Settings » Advanced Tools » License Management » Renew License 
tab. 

3. In the Enter New License Key (new user or module) section, click Enter New Key, paste the 
Subscription Key into the field, and click OK. 

WorkBook displays a confirmation message. 

4. Click OK. 

Note: If there are any errors during the installation process when reloading reports, they are 
listed in the installation log. Resolve any errors and reload your reports manually through the 
application. 
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5. If it is for a Production Server, click Mark System as Production. 
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Migration Reconfiguration 

Storage Providers 
If you have moved your WorkBook installation to a new server, and you use a Local Data Provider, be 
sure to move this database if they are on the same server, and update the Data Provider location in 
Settings » Folders, Reports, & Documents » Storage and Folders » Storage Provider tab. 
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Emails 
If you have changed the URL as part of the migration, update System Variable 911 HTML5 Version 9 
URL Redirect in Settings » Global System Settings » System Variables to match the new URL. 

 

A-record 
After the migration is complete, update any records that point the URL to the server. 
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Appendix A: Microsoft Internet Information Server 
(IIS) Installation on Windows Server 

Microsoft (IIS) is already Installed on Windows Server 2019 to 
2022 
If you have already enabled the Web Server role on your web server, you must check Features and Role 
Services. 

To check Features and Role Services on Windows Server 2019 to 2022: 

1. Launch Server Manager. 

2. In the left menu, click IIS. If the IIS option is not listed, perform the following steps for installing 
Microsoft IIS for the first time. 

3. In the Roles and Features group, verify that all of the required role services (as listed in Installing 
Microsoft IIS for the First Time) are installed. 

Installing Microsoft IIS for the First Time on Windows Server 
2019 to 2022 
If you are installing Microsoft IIS for the first time, perform the following the steps. These steps are 
required for proper detection of ASP.NET. 

To install Microsoft IIS on Windows Server 2019 to 2022: 

1. Log in to Microsoft Windows Server as a domain or local administrator. 

2. Launch Server Manager. 

3. On the Server Manager dashboard, select Add Roles and Features. 

4. On the Before You Begin page, click Next. 

5. On the Select Installation Type page, select Role-Based or Feature-Based Installation and click 
Next. 

6. On the Select Destination Server page, select Select a Server from a Server Pool and click Next. 

7. On the Select Server Roles screen, expand Web Server (IIS) and enable the following options: 

▪ Web Server (IIS) » Web Server » Common HTTP Features 

▪ Default Document 

▪ HTTP Errors 

▪ Static Content 

▪ HTTP Redirection 

▪ Web Server (IIS) » Web Server » Health and Diagnostics 

▪ HTTP Logging 
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▪ Request Monitor 

▪ Tracing 

▪ Web Server (IIS) » Web Server » Performance 

▪ Static Content Compression 

▪ Web Server (IIS) » Web Server » Security 

▪ Windows Authentication 

▪ Request Filtering 

▪ Web Server (IIS) » Web Server » Application Development 

▪ .NET Extensibility 4.8 

▪ ASP.NET 4.8 

▪ Web Server (IIS) » Management Tools 

▪ IIS Management Console 

▪ IIS Management Scripts and Tools 

Click Next. 

8. On the Select Features page, expand .NET Framework 4.8 Features and select .NET Framework 
4.8 and ASP.NET 4.8. 

Click Next. 

 

9. On the Confirm Installation Selections page, click Install. 

Installing Microsoft .NET 8 
The server requires that you have Microsoft .NET 8 installed. 

To install .NET 8.0: 

1. Go to the .NET 8.0 website using this link. 

2. Go to the ASP.NET Core Runtime section and find the OS / Installers / Binaries table. 

3. Under Windows » Installers, find and download Hosting Bundle. 

4. Double-click the file, and then click Install. 

5. After the installation is complete, click Close. 

 

Notes: These steps enable the .NET features. However, you must also install the currently 
supported version of the .NET on the server, if you have not already. For more information 
see Software Requirements. 

https://dotnet.microsoft.com/en-us/download/dotnet/8.0
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Appendix B: Creating the Website and Configuring 
the IIS Settings (Alternate Method) 
Use this method if you want to create a dedicated website for reports. Having a separate report website 
can generally be less demanding of system resources and might help to speed up processing time. 

Create the Website and Configure the IIS Settings 
1. In your browser, go to https://www.iis.net/downloads/microsoft/url-rewrite. 

2. Download and install the URL Rewrite extension. 

3. Open the Internet Information Services (IIS) Manager. 

4. Expand the server element. 

5. Right-click Sites and click Add Website on the context menu. 

6. Use the fields and options in the Add Website dialog box to create the WorkBook website, then 
click OK. 

Make sure that the Physical Path field points to the installation folder that you specified when 
you installed the Database and Web tiers, and that the Port field points to an unused port 
number. 

7. Expand the newly created WorkBook website. 

8. Right-click the api folder and click Convert to Application on the context menu. 

9. In the Add Application dialog box, accept the default settings and click OK. 

10. Right-click the Report folder and click Convert to Application on the context menu. 

11. In the Add Application dialog box, accept the default settings and click OK. 

Remove Report as Application 
1. Right-click Report and click Remove on the context menu. 

2. When prompted for confirmation, click Yes. 

Rename the Report Folder 
1. Right-click the WorkBook website that you created and click Explore on the context menu. 

2. Locate the Report folder and rename it to something else, for example, ReportSite. 

Create a Separate Report Website 
1. Go back to the IIS Manager and press F5 on your keyboard to refresh. 

2. Right-click Sites and click Add Website on the context menu. 

https://www.iis.net/downloads/microsoft/url-rewrite
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3. Use the fields and options in the Add Website dialog box to create the report website, then click
OK.

4. Expand the report website that you just created.

5. Right-click the api folder and click Convert to Application on the context menu.

6. In the Add Application dialog box, accept the default settings and click OK.

Configure the web.config File 
1. Right-click the WorkBook website and click Explore on the context menu.

2. Locate the web.config file and use the context menu to open it in Notepad.

3. Scroll to the bottom and place your mouse cursor just before <system.webServer>.

4. Paste the following string, then save the file.

 <rewrite> 

 <rules> 

 <rule name="WorkBook Report Redirect" stopProcessing="true"> 

 <match url="^report\/(.*)" /> 

 <conditions trackAllCaptures="true"> 

 <add input="{CACHE_URL}" pattern="^(.+)://" /> 

  <add input="{CACHE_URL}" 

pattern="(report\/api\/)|(report\/.*\.a)|(report\/.*(\.html))" /> 

 </conditions> 

 <action type="Rewrite" url="http://{SERVER_NAME}:1000/{R:1}" /> 

 </rule> 

 <rule name="DXR.axd" stopProcessing="true"> 

 <match url="DX[X]?R.*\.axd" /> 

 <action type="Rewrite" url="http://{SERVER_NAME}:1000/{R:0}" /> 

 </rule> 

 <rule name="WebResource.axd" stopProcessing="true"> 

 <match url="WebResource\.axd" /> 

 <action type="Rewrite" url="http://{SERVER_NAME}:1000/{R:0}" /> 

 </rule> 

  </rules> 

 </rewrite> 

Attention: Make sure that the Physical Path field points to the folder that you just 
renamed—in this example, ReportSite—and that the Port field points to an unused port 
number that is different from that of the WorkBook website. 
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Edit the Rules Using URL Rewrite 
1. Navigate to the WorkBook website.

2. In the right pane of the IIS Manager, double-click URL Rewrite.

3. In the URL Rewrite pane, double-click a rule.

4. In the Edit Inbound Rule pane, change the value of the Rewrite URL field:

▪ Replace 1000 with the port that you used for the report website.

▪ Make sure that the binding type—http or https—matches that of the WorkBook website.

5. In the Actions pane, click Apply.

6. Apply the same changes to the two other rules.


